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New College Web Site Offers New Online Services
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After a year of planning and restructuring, designing and
coding, Lake Forest College has a new web site
(www.lIfc.edu). The result of hundreds of hours of work, the
new site is designed to serve the needs of campus users as
well as the thousands of visitors that access Lake Forest Col-
lege information.
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The new Lake Forest College pages boast a host of new fea-
tures, most noticeable of which is the strong visual appear-
ance of the site. Each month, a new home page graphic will
highlight a different aspect of the beauty of our campus. Less
frequently, the interior graphics will also change to add vari-
ety to the second level of the site.
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One popular service implemented with the new web site is iy oy
the Online Directory (accessible via the title bar on the top
of every page) containing contact information for students,
faculty, staff, and participating alumni. Much like the an-
nual paper directory in its format, the Online Directory has
the advantage in that it can accommodate changes and additions all year round (please let us know if you notice information that needs
updating). Faculty members can look up student email addresses, box numbers, and home information. For privacy reasons, requests

from outside the College will receive only a student’s email address, graduation year, and web address (if applicable). :-(-se-:e- Web, page 2).

55 H T Bl Lsbs PormrL Pl 0808 22K YEG

The new home page boasts a new online directory, improved design
and interface for easy navigation, and information on campus events.

From the Director

THIS |53EUE; Y2K at LFC: An Overview of the Issues

Feature Article 1 Robert Frost had it all wrong. When it comes It’s most likely that we will experience some
to the end of the world, it’s not a question of inconveniences due to the Y2K bug, but they
From the Director ..........ccccoecuucnuee. 1 fire orice, it’s Y2K. At least that’s what some probably aren’t going to be so serious that
LIT Licisons 2 of the Year 2000 doomsayers would have you should start converting all of your as-
you believe. sets into Krugerrands and begin making
TechTips (PUIFOUL) e 34 plans to move into a cave in the hills.
By now you are probably well aware of the
Fond Adieus and Bienvenu ............ 5 origin of the Y2K problem. A seemingly in- Lake Forest College has been working on
LIT Events 5 significant computer programming conven- its Year 2000 plans for over eighteen months.
tion in which software was written to accept  Our key administrative system, the system
What's NeW in LIT e 6 only two digits as day, month, and year in- that keeps track of such things as registra-
dicators (i.e. dd/mm/yy), has turned out to tion, grades, student billing, and payroll, is
be, in fact, quite significant. When calen- anewly-developed system that is fully Y2K
Office of Library & dars roll over to 01/01/00, some computers compliant. Our new library system, DRA,
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and microprocessors will have difficulty
determining what to make of a year ending
with the digits “00.” Is it 2000 or 1900? No
one really knows for sure how our lives will
be affected next January.

is also compliant. In addition, all hardware
and software purchased by LIT within the
last two years (with the possible exception

1 (see Y2K, page 6)
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Administrative Departments

Alumni/Development Anchalee Hocharoen (5110)
Admissions Vince Costa (5115)
Athletic Department Nick Ritter (5112)
Business Office Vince Costa (5115)

Dean of the College Marylin Bell (5114)

Dean of the Faculty Marylin Bell (5114)
Facilities Management David Levinson (5059)
Financial Aid Marylin Bell (5114)
Marketing and Communications David Levinson (5059)
President’s Office Marylin Bell (5114)

Academic Departments
Humanities (except History & Music) Valerie Archambeau (5116)

Melinda Dermody (5063)
Music David Levinson (5059)
Social Sciences and History Diane Snedden (5113)

John Brandt (5066)
Natural and Mathematical Sciences Marylin Bell (5114)

Contacts for Specific Services
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Managing Editors Melinda Dermody and Valerie Archambeau

Editorial Staff .......................... John Brandt, Jim Cubit, Sarah Drehobl,
Vanaja Menon, and Diane Snedden

Graphic Design ......................... Valerie Archambeau and Melinda Dermody

Issues of LIT BiblioFiles are available on the World Wide Web at
http://www.lib.lfc.edu/bibliofiles/

Articles may be reprinted provided proper attribution is given.

Web (cont’d from page 1)

The new web pages contain a number of details to help visitors
access campus information. At the bottom of every page we have
added a drop-down menu listing all of the
main areas of the site. To jump from one
area (for instance, “Academics”) to an-
other (“News and Events”), click on the
desired location in the drop-down menu. """
We have also added a title bar at the top
of all pages that indicate the area of the
site currently accessed. This bar also con-
tains links to our College search page, di-  |vor

rectories, contact page, and home page. |t #=taipais

=1

News and Events is another new area of the site, maintained by the
Office of Marketing and Communications (OMC). Online versions
of LFC publications like the Spectrum and Spector are now avail-
able from this area.

We have also expanded the Community area of the site, providing
information on local restaurants, movie theaters, and cultural op-
portunities in the Lake Forest area as well as in Chicago.

Work is now beginning on a new campus tour, which will include
video clips, 360-degree panoramas of the campus, and supplemen-
tary information. Suggestions for this project are welcome.

The updated web site represents a 14 month effort with various
committees working on the new design, organization, and policies
for the new site. Student web assistants provided invaluable ser-
vice, working with the design and assisting a number of depart-
ments in creating and updating pages.

The Web Committee views the unveiling of the new site as Phase 1
of the implementation. In Phase 2, programs will be developed to
ensure the ongoing vitality of the site. LIT intends to set up a num-
ber of services to keep the information on the web fresh and dy-
namic. Part of this entails tailoring a level of support that fits the
needs of individual departments and offices.

LIT is seeking a Web Contact in each department to help coordi-
nate the maintenance of that department’s site. We are also plan-
ning a series of workshops to assist our contacts in the creation
and upkeep of their pages.

Archives and Special Collections Art Miller (5064)
Audio Visual Services Mary Moss (5058)
Book Acquisitions Anne Kale (5060)
Circulation (overdues, etc.) Karen Ludlow (5061)
Computer Hardware Purchases Linda Mathiesen (6220)
Computer Supplies Jan LePak (5120)
Interlibrary Loan Susan Cloud (5062)
LFBBS Diane Snedden (5113)
Periodicals Rita Koller (5065)
Reference Desk 5074

Software Licensing Diane Snedden (5113)
Switchboard & Computer Supplies Jan LePak (5120)
Telecommunications Linda Mathiesen (6220)
Web Authoring Valerie Archambeau (5116)
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special pull-out section

TechTips

More ILLINET Online Tips

Renewing a Book
Books can easily be renewed online.

1. Click the Options menu and select Borrower Information.
2. From the next menu, select Items Checked Out.
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In the ID line, type the 14 digit barcode number.

4. Inthe PIN line, type the last 4 digits of your social security
number.

5. From the list, select the number of the book you want to
renew and press Enter.

6. TypeY for yes, when asked if you’d like to renew the book,
then press Enter.

7. The new due date will be reflected in the Items Checked

Out list.

Checking Borrower Information

In addition to renewing items, Borrower Information allows ac-
cess to other information.

1. To see if you have accrued any fines, click on the Options
menu, select Borrower Information, and then select Fines.

2. The Requests option in Borrower Information displays
any book requests that you have recently placed.

3. Finally, the Change Pin option allows you to change your
Pin number to something other than the last 4 digits of your
social security number.

Things To Remember About Ordering Books
e Inorder to request books from other libraries, you must log
in with your Library ID number (14 digit barcode number).
e Ifyou log in as Guest, you will not be given the choice to
request a book from another Library.
e It is not necessary to specify a school — the system will se-
lect the school.

Emailing Records
You can send item records to yourself through email:

1. From the results list, select Mark Citations from the Op-
tions menu.

2. In the box, type the numbers of the books that you want to
email then press Enter.

3. Select Citation Manager from the Options menu, and then
select Procedures.
From the next menu, select Mail Records.
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5. At the next screen, type your email address at the Email
Address prompt and press Enter.

6. The records will be emailed immediately, and you will re-
ceive no further notification.

Voicemail Shortcuts
Using Express Messaging

The Express Messaging service allows you to access a person’s
voicemail box directly.

1. Dial 6246 (on campus) or 735-6246 (off campus).
2. When asked, enter the extension (“mailbox”) of the person
for whom you are leaving a message.
3. Press the number sign (#).
4. Leave your message, then hang up.
You can only leave messages for one person at a time using Ex-
press Messaging.

Forwarding a Message in Voicemail

1. Access the message you wish to forward.

2. Dial 73.

3. Enter the extension of the person or persons for whom you
are forwarding the message. If you are forwarding to more
than one person, separate the extensions with the number
sign (#); end the list with an additional number sign.

4. Ifyou wish, press 5 to leave a brief message explaining the
nature of the mail you are forwarding; press the number
sign when you are finished recording.

5. To send the message, dial 79. (If you change your mind and
wish to cancel, dial 76.)

SprinGg 1999
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special pull-out section

TechTips

Computing Tips
Using Mathematical Expressions in MS Word

Would you like to put a mathematical expression into a word-pro-
cessing document? With Office 97 (PC) or Office 98 (Mac) you
can embed various types of information from Office Tools, a set of
helper applications. In this example, we will be inserting an equa-
tion, but clip art, graphs, or organizational charts may also be in-
serted with other Office Tools. To use the Office Tools:

1. In your active document, place the insertion point where
you would like your object to appear.

2. Click on the Insert menu, then select Object. This makes

the “Object Selection List” window appear.

Click on the Create New tab.

4. Select Microsoft Equation from the list in your window,
and click OK. Microsoft’s Equation Editor toolbar appears
with various equation buttons. A box with handles will also
appear. This will be the working area that is “embedded”
into your document.

5. Enter your equation by clicking on the appropriate buttons
on the equation toolbar and using numeric keys.

6. Exit the “editing mode” of Microsoft Equation by clicking
anywhere outside the embedded equation window. The
handles of the box will disappear, indicating that you have
exited Microsoft Equation.

(98]

Note that when you move your mouse pointer over the embedded
object, crosshatch arrows appear. If you click on the object, the
handles reappear and the object can be moved. If you wish to fur-
ther edit your equation, you must double click over the object to
activate your Equation Editor Tools.

Take Control in MS Office

Tools: Options: Spelling and Grammar Menu

Do you get annoyed by the red and green squiggly lines Word
places underneath your words? You can customize how the Spell
Check works. To change the Spell and Grammar Check options,
click on the
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(Mac). Click
the Spelling
& Grammar
tab. Check
and uncheck
boxes to turn off and on features such as “Check spelling/gram-
mar as you type.” You can also ask the spell check to ignore
words in UPPERCASE and Internet addresses.

T |

Tools: Options: Save Menu

The Save tab in the Options Window (or Preferences window for
Mac) allows you to specify AutoRecovery and other save features.
LIT recommends unchecking the “Allow fast saves” option, since
Fast Saves can occasionally cause file corruption.

LIT recommends that you activate “AutoRecovery” for every 5-
10 minutes. The AutoRecovery saves a temporary file, in the event
of a power failure or crash.

Typically, when the AutoRecover feature is turned on, Word auto-
matically opens any recovered documents when you restart Word
after a power failure or similar problem. However, if Word did not
automatically open the recovery file, you can manually open it.
By default, the file is located in the Temp folder, which in turn, is
in the Windows folder. Please note:

*  AutoRecover is not a replacement for regularly saving your
documents, because the recovery file is deleted when you
save or close a document.

*  When Word automatically opens a recovery file, the recov-
ered file is deleted if you choose not to save the file.

Tool: Options: Compatibility
To use this feature, follow these steps:

1. Click on the Tools menu, and select Options (Windows) or
Preferences (Mac), then click the Compatibility tab.

2. In the “Recommended Options For” box, click the file for-
mat of the file you are working with. Select Custom to
specify individual options.

3. In the Options box, select the options you want.

Note: Changing the options affects only the display of a document
while you’re working with it in Word. It does not permanently
change any formatting in the document.

Is Your Word Software Too Bossy?

Customize the pesky AutoCorrect feature! Click on the Tools menu
and select AutoCorrect. You will find four tabs of options available:
AutoCorrect,
AutoFormat As
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If Word is putting capital letters where you do not need them, click
on the AutoCorrect tab, then turn off features such as “Capitalize
the first letter of sentences.” Do you dislike the way Word inserts
numbers (or bullets) in front of your lists? Click on the AutoFormat
As You Type tab and deselect “Automatic numbered (bulleted) lists.”
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LIT EVENTS

Library Workshops

Check—in at the Reference Desk.

ILLINET Online (Book Searching)
Monday March 8, 3:00—4:00pm

Databases for the Humanities
Tuesday March 16, 3:00—4:00pm

Databases for the Social Sciences
Thursday March 18, 10:00—-11:00am

Databases for the Sciences
Wednesday March 24, 10:00—11:00am

IT Seminars

Watch your email for more informa-
tion on these upcoming computing
workshops:

Intro to Windows 95
Thursday March 4, 2:00—4:00pm

Intro to Mac
Friday March 5, 2:00—4:30pm

Searching the Web
Monday March 8, 10:00—11:00am

Netscape Mail
Thursday March 11, 10:30-12:00pm

Web Page Design (HTML)
Friday March 12, 2:00—4:30pm

Making Window 95 Work for You
Thursday March 18, 10:00—-11:30am

Using Microsoft Word
Friday March 19, 2:00—4:30rm

Intro to Excel
Tuesday March 23, 2:00—4:30pm

FTP Basics: Publishing Web Pages
Thursday March 25, 2:00-3:00pm

Website Maintenance
Thursday April 1, 2:00-3:30pm

Desktop Maintenance
Thursday April 8, 2:00-3:30pm

Fond Adieus and Bienvenu

We in the Office of Library and Informa-
tion Technology are accustomed to dealing
with rapid change. This semester, those
skills will come in handy as two valued staff
members leave us to take on new chal-
lenges. They will be missed, and those of
us remaining, with the help of new staff,
will strive to fill the void they have left.

On February 26th, the Lake Forest College
Library reluctantly but fondly bid adieu to
Vanaja Menon, Associate College Librar-
ian. Vanaja has accepted a position as As-
sistant Director for Public Services at the
University of Wisconsin-Milwaukee.

Her many long years of dedicated service
began in 1986 as an acquisitions and tech-
nical services assistant. While working full-
time, she completed her Master’s Degree
in Library Science at the University of Chi-
cago in 1989, and was subsequently pro-
moted to Assistant Librarian. She has served
as the Associate College Librarian since
1992. Her dedication to service and, most
especially, her valued role as a colleague
and friend will be greatly missed.

Upon Vanaja’s departure, Melinda Dermody
assumes the position of Head of Public Ser-
vices. Melinda will continue as a Refer-
ence Librarian while coordinating the
Library’s Circulation, Interlibrary Loan, and
Reference services.

In a development which has caused a con-
siderable reassignment of professional re-

)

Welcome, Cory!

Vanaja and Gee not pictured) will be ssed.

sources, Gene Shin’s last day as Network
Administrator was December 31st, 1998.
Nick Ritter and David Levinson now coor-
dinate campus network services.

David also remains responsible for library
computing as Systems Librarian. John
Brandt, in addition to managing Govern-
ment Documents, is moving downstairs in
the Library to take over supervision of the
Library’s Technical Services. Corinne
(Cory) Stevens completes this round of
musical chairs by joining the Library staff,
taking over John’s Reference duties upstairs.

Cory begins her appointment as a Refer-
ence Librarian on March 8th, 1999. Cory
received her Bachelor’s degree from Pace
University in New York, and her Master of
Library Science degree from the University
of Texas-Austin. For the last five years, she
has served as a Catalog Librarian at Will-
iams College in Williams, Massachusetts.
In addition to providing reference service,
Cory will lend her considerable experi-
ence and expertise to the Library’s cata-
loging efforts.

In other professional development news,
Library Serials Supervisor Rita Koller re-
ceived her Master of Library Science de-
gree from Dominican University in
January. While working full-time man-
aging all of the Library’s periodical ac-
quisitions and processing, Rita has earned

both her Bachelor’s and Master’s degrees,

taking one or two courses at a time. We are
very proud of her hard work and commend-
able accomplishments.

SprING 1999
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What's New in Library and Information Technology

Trend of Full Text Databases

Although there are notable exceptions, the
majority of Library index resources are now
available as electronic databases. The cur-
rent trend for these databases is to provide
the full text of the entire article rather than
a simple citation. Of the 60 plus databases
available at Lake Forest College, over a
dozen provide full text articles.

In addition to being very convenient and
useful for Library users, full text databases
enhance the Library’s collection in a vari-
ety of ways. One of the main benefits of
full text databases is that they expand the
Library’s periodical collection. An article
that LFC does not own would normally be
ordered through Interlibrary Loan. How-
ever, if that article is available in a full text
database, it is instantly accessible. The Li-
brary has compiled a list of the journals
available in full text databases at:
www.lib.Ifc.edu/fulltext/index.html

Additionally, many journals are now being
published in both print and electronic for-
mat. For instance, Diacritics, an academic
journal on literary criticism, is available in
an online version through Project Muse (de-
scribed below). Also, numerous resources
that were formerly available only in print,
such as some key government documents,
can now be found online.

Y2K is On Its Way,

nor issues”) is also compliant. Some older
software being used by individuals may
have to be upgraded or replaced. We do
have Y2K compliant versions of all soft-
ware programs supported by LIT, and will
be recommending that those faculty and
staff presently using older software update
over the coming months.

At present we are in the process of testing
the BIOS (Basic Input Output System) on
College-owned PCs to identify and resolve
potential Y2K problems. We know that
some PCs have BIOS programs that will
interpret January 1, 2000 as January I,
1900. The first time these computers are
powered up after January 1, 2000, DOS
or Windows will attempt to rectify the date
discrepancy by resetting the date to Janu-
ary 4, 1980, the earliest date the computer

While useful for a variety of reasons, this
full text trend also raises some concerns for
Libraries. Students often confuse these da-
tabases, for which the Library pays a large
subscription fee, with the free resources
found on the web. Most of this confusion is
caused by the fact that although the
Library’s “for-charge” databases are avail-
able through the web, these databases are
accessible only to LFC users. Many students
mistakenly see the Library’s databases and
the web as one in the same.

The main problem with this misunderstand-
ing is that the resources available through
the Library’s full text and other databases
are much more reliable sources of informa-
tion than many web pages, which can liter-
ally be published by anyone. Evaluation
skills are essential in selecting resources on
the web, while using resources from Library
databases eliminates some of the evaluative
guesswork involved in research.

Another concern is that once students learn
about full text databases, they often will use a
full text database whether or not it is the best
source for their research. Many of the full text
databases are “general topic” in nature, which
is appropriate for some research. However,
some in-depth research requires more com-
prehensive subject-specific databases (ex-
amples: PsycInfo and MLA) and many
students are unwilling to use any subject-spe-

(cont’d from page 1)

can recognize. This scenario has the po-
tential to create conflicts with date sensi-
tive software. As we encounter potential
BIOS problems, we will correct them ei-
ther through a software patch, BIOS up-
grade, or in some cases, replacement of
the machine.

A task force is coordinating a campus wide
Y2K effort that is in the process of identi-
fying all of the key vendors and systems
used by the various campus departments.
All vendors will be contacted and asked
to provide assurance that their business is
Y2K compliant. This is being done to
minimize any potential disruption in the
provision of mission-critical goods and
services to the College and to ensure that
the campus environment remains safe and
comfortable for all of us.

cific database if it is not full text. Physically
locating an article in the Library is much less
convenient than printing the article from the
computer, but the added effort is rewarded
with better, relevant resources.

Finally, with students’ easy access to com-
plete, downloadable articles, plagiarism is a
concern for many professors. LFC Librarians
are available to assist professors in determin-
ing whether or not a paper has been copied
from a full text databases or the web. Li-
brarians also welcome the opportunity to
provide Library research instruction sessions
if professors find that their students’ sources
are inadequate, or leaning too heavily on full
text, web, or other non-book sources.

Project Muse

The Library has recently purchased a sub-
scription to Project Muse, a service provid-
ing web-based access to over 40 journals
I"HILOSOPHY,
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These journals are just a few of the
many available from Project Muse.

published by Johns Hopkins University
Press. Most of the journals, which cover the
Humanities, Social Sciences, and Math-
ematics, begin coverage around 1996. The
full text of these articles includes all illus-
trations, tables of contents, bibliographies,
citations, and endnotes. Keyword and bool-
ean searches are available for all of the jour-
nals in the database. Project Muse is
accessible from any campus-networked
computer. To access Project Muse, go to:
www.lib.lfc.edu/muse/

Office Hours for Faculty

Diane Snedden will hold office hours Mon-
day, Wednesday, and Friday from 12:00-
1:00 p.m. to help faculty and staff struggling
with new technology. Drop by her office in
Johnson room 175B and she will assist you.
You can also set up an appointment by call-
ing x5113. Scanning and color printing will
also be available.
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